Session 7

Log-linear Models

Multi-way Tables 7-6
Example 1 7-8
Interpretation of Parameters 7-12
Continuous Covariates 7-13
SPSS commands for Log-Linear Models 7-14
Practical Session 7: Log-Linear Models 7-15
Session 7: Log-Linear Models

The analysis of multi-way contingency tables is based on log-linear models. In order to develop this theory, consider the simpler situation of a two-way tables as produced by a cross-tabulation of SEX by LIFE (GSS91 data).

![Crosstabulation Table]

We might ask how were these results derived?

Firstly, we make the assumption that the two variables are independent. This means that we are assuming that the probability of a response to LIFE is the same for both sexes, so that the probability of being in a particular cell, e.g. SEX=1 and LIFE=2 can be found by multiplying together the probability that SEX=1 and the probability that LIFE=2 (for both sexes). Knowing the total sample size, we can then work out the expected cell frequency counts. We measure the discrepancy between the observed and expected cell counts using the general principle of Deviance based on the Likelihood. The statistical distribution of the cell counts is the Multinomial distribution, which is a generalisation of the Binomial distribution. It turns out that, mathematically, we get exactly the same results if we assume the cell counts have the Poisson distribution. This Deviance measure is tested using the Chi-squared distribution following general theory. A modified version due to Karl Pearson is often referred to as the chi-squared goodness-of-fit statistic.
How do we express this as a statistical model?

Consider the model for the cell probabilities:

\[ p( \text{SEX}=i, \text{LIFE}=j ) = p( \text{SEX}=i ) \times p( \text{LIFE}=j ) \]

So, for \( p( \text{SEX}=1 \text{ (male)}, \text{LIFE}=2 \text{ (routine)} ) \) we need \( p( \text{SEX}=1 ) \) and \( p( \text{LIFE}=2 ) \).

On the basis of the sample we see that we can estimate \( p( \text{SEX}=1 ) \) by \( \frac{425}{980}=0.434 \) as the proportion of males in the sample. Similarly, we can estimate \( p( \text{LIFE}=2 ) \) by \( \frac{505}{980}=0.515 \). This is based on the assumption that it is the same for males and females, i.e. that it is independent of SEX.

Thus, we can now estimate \( p( \text{SEX}=1, \text{LIFE}=2 ) \) by \( 0.434 \times 0.515 = 0.2235 \).

The expected count in the cell would then be \( 0.2235 \times 980 = 219.0 \) (see SPSS output).

This is carried out for each cell of the table and the observed counts are compared to these expected counts using some definition of Loss. The Deviance loss function is referred to as Likelihood Ratio. The form of this loss function is derived from the assumption that the counts have the Multinomial distribution. Following the general theory this has approximate distribution given by the Chi-squared distribution. Testing the value of this Loss is a test of our assumption of independence. The modified version of this, due to Pearson, is also given. The advantage of the Pearson version is that the approximate Chi-squared assumption holds more accurately when expected counts are small. The approximation can become unreliable when expected counts become very small (e.g. close 1). We may be forced to amalgamate categories to increase these small expected counts.

We can see that the model for \( p( \text{SEX}=i, \text{LIFE}=j ) \) is a simple multiplicative model. We can turn it into a simple additive model by taking logs:

\[ \log p( \text{SEX}=i, \text{LIFE}=j ) = \log p( \text{SEX}=i ) + \log p( \text{LIFE}=j ) = a_i + b_j \]

We have seen how to deal with such models using Factors in General Linear Models. Thus, on a log scale the model is linear and is often referred to as a log-linear model. In this form the parameters are the logs of the probabilities so are more difficult to interpret immediately.

Thus, we can see that this is an example of a simple non-linear model with a particular Loss function derived from the Multinomial distribution and thus fits into our general description of a Statistical Model.

These models are fitted through the module:
Select the categorical variables as Factors.

Open the Model dialog box:

The default is Saturated, switch to Custom and build a model in the usual way.
Also the default output includes tables and plots of residuals, which are not usually needed until a final model has been selected. Switch these off in the Options dialog. If parameter estimates are required switch this on in the Options dialog.

**General Loglinear**

**Table Information**

<table>
<thead>
<tr>
<th>Factor</th>
<th>Value</th>
<th>Observed</th>
<th>Expected</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Count</td>
<td>%</td>
</tr>
<tr>
<td>LIFE</td>
<td>Exciting</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SEX</td>
<td>Male</td>
<td>213.00 (21.73)</td>
<td>188.21 (19.21)</td>
</tr>
<tr>
<td></td>
<td>Female</td>
<td>221.00 (22.55)</td>
<td>245.79 (25.08)</td>
</tr>
<tr>
<td>LIFE</td>
<td>Routine</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SEX</td>
<td>Male</td>
<td>200.00 (20.41)</td>
<td>219.01 (22.35)</td>
</tr>
<tr>
<td></td>
<td>Female</td>
<td>305.00 (31.12)</td>
<td>285.99 (29.18)</td>
</tr>
<tr>
<td>LIFE</td>
<td>Dull</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SEX</td>
<td>Male</td>
<td>12.00 (1.22)</td>
<td>17.78 (1.81)</td>
</tr>
<tr>
<td></td>
<td>Female</td>
<td>29.00 (2.96)</td>
<td>23.22 (2.37)</td>
</tr>
</tbody>
</table>

**Goodness-of-fit Statistics**

<table>
<thead>
<tr>
<th></th>
<th>Chi-Square</th>
<th>DF</th>
<th>Sig.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Likelihood Ratio</td>
<td>12.1095</td>
<td>2</td>
<td>.0023</td>
</tr>
<tr>
<td>Pearson</td>
<td>11.9941</td>
<td>2</td>
<td>.0025</td>
</tr>
</tbody>
</table>

**Correspondence Between Parameters and Terms of the Design**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Aliased</th>
<th>Term</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>Constant</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>[LIFE = 1]</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>[LIFE = 2]</td>
</tr>
<tr>
<td>4</td>
<td>x</td>
<td>[LIFE = 3]</td>
</tr>
<tr>
<td>5</td>
<td></td>
<td>[SEX = 1]</td>
</tr>
<tr>
<td>6</td>
<td>x</td>
<td>[SEX = 2]</td>
</tr>
</tbody>
</table>

Note: ‘x’ indicates an aliased (or a redundant) parameter. These parameters are set to zero.
Parameter Estimates

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Estimate</th>
<th>SE</th>
<th>Z-value</th>
<th>Asymptotic 95% CI</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>3.1450</td>
<td>.1586</td>
<td>19.83</td>
<td>2.83 3.46</td>
</tr>
<tr>
<td>2</td>
<td>2.3595</td>
<td>.1633</td>
<td>14.45</td>
<td>2.04 2.68</td>
</tr>
<tr>
<td>3</td>
<td>2.5110</td>
<td>.1623</td>
<td>15.47</td>
<td>2.19 2.83</td>
</tr>
<tr>
<td>4</td>
<td>.0000</td>
<td>.</td>
<td>.</td>
<td>.</td>
</tr>
<tr>
<td>5</td>
<td>-.2669</td>
<td>.0645</td>
<td>-4.14</td>
<td>-.39 -.14</td>
</tr>
<tr>
<td>6</td>
<td>.0000</td>
<td>.</td>
<td>.</td>
<td>.</td>
</tr>
</tbody>
</table>

Multi-way Tables

With this formulation we can generalise it to model multi-way contingency tables. The simplest model would assume all Factors are independent of each other leading to more additive terms in the log-linear model. We can then build more complex models by adding interaction terms between pairs of Factors allowing for the non-independence of these Factors.

Examples:

- \( A + B + C \)
  - A, B and C are mutually independent

- \( A + B^*C \)
  - A is independent of B and C, B is dependent on C

- \( A^*B + B^*C \)
  - A is dependent on B, and C is dependent on B, but there is no direct dependence of A on C

This last example is very important and can be expressed as “A and C are \textit{conditionally} independent given B”. The practical importance of this is that if we wish to predict A we need only know B, C is irrelevant. However, if we considered just the two-way table \( A \times C \) we may well get a statistically significant association due to the mutual dependence of A and C on B. This is analogous to \textit{spurious correlation} in Normal regression models. Thus it is important when we have many factors that are apparently inter-related that we separate the direct associations from the indirect (spurious) associations. This we can only do by considering models for the multi-way tables.

Even more complex interactions between triples of Factors can be added, allowing for more complex inter-relationships. Interpretation of parameter values becomes increasingly complicated. For example, the two-way interaction parameters are equivalent to \textit{log odds-ratios}, which can be transformed back to odds and odds-ratios.

While quantitative interpretation of interactions may be difficult, qualitative insight may be gained by simply testing for the presence of significant interactions. The absence of an interaction will mean a simplification in the
inter-relationships. For complex models a **Graphical** representation can be very helpful.

The represents the model: \( A + B + C + D + E + A*B + B*C + B*E + C*D + D*E \)

The rule for drawing this graphical representation is simple: The circles represent the factors and we connect factors if they have an interaction. The interpretation of the graph is also simple: By considering “routes” from one node to another along the connecting lines we can derive **conditional independence**’s.

For example, consider all routes from all nodes to A. We see that they must go through node B. This can be interpreted as: A is **conditionally independent** of C, D and E given B. The practical interpretation of this is that, to predict A we need only know the value of B, all other information is superfluous.

Searching for the simplest model that adequately represents the data can be laborious. For example, with 5 factors there are 32 possible models to test. Stepwise procedures can be used to step through each interaction in turn removing those that are not significant.

In SPSS we can use a stepwise model selection procedure through

```
Analyze
    Loglinear
        Model Selection…
```

In this procedure we can only select **Factors** (note you will have to provide the range of factor levels for each factor).

The only procedure is **Backward Selection**. The default starting point is the saturated model, use the **Model** dialog to change this.

By default the maximum number of steps is set to 10, you may need to increase this for complex models.
Example 1

The datafile vote.sav contains data on the voting intentions (only Labour vs Conservative recorded) of a sample of people and their CLASS, SEX and AGE (grouped). However, this data is already in aggregate form, that is the original data has been cross-tabulated and only the cell frequencies (freq) retained. Below is a portion of the data:

In order to analyze such data correctly we must declare FREQ as a Weight Cases variable, as follows:

Data → Weight Cases
Weight Cases by select FREQ

Now we proceed with Log-linear analysis

Analyze → Loglinear → General...

Factors = class age sex vote
Model = age class sex vote

Goodness-of-fit Statistics

<table>
<thead>
<tr>
<th></th>
<th>Chi-Square</th>
<th>DF</th>
<th>Sig.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Likelihood Ratio</td>
<td>234.2176</td>
<td>51</td>
<td>3.E-25</td>
</tr>
<tr>
<td>Pearson</td>
<td>222.1450</td>
<td>51</td>
<td>3.E-23</td>
</tr>
</tbody>
</table>

Thus these factors are clearly not independent.
If we now include a VOTE by CLASS interaction:

Factors = class age sex vote
Model = age class sex vote vote*class
Then the Likelihood Ratio Chi-Square has reduced from 234.22 to 82.82, a difference of 152.4 on 2 degrees of freedom. This is highly significant (though we do not get this information from SPSS) and indicates that the \( \text{VOTE} \times \text{CLASS} \) interaction is significant. However, we cannot rely on this without testing all the other possible interactions.

We will use Model Selection to search for the simplest relationship.

**Analyze → Loglinear → Model Selection...**

Factors = class(1 3) age(1 5) sex(1 2) vote(1 2)
Model = saturated

******* HIERARCHICAL LOGLINEAR *******

Tests that K-way and higher order effects are zero.

<table>
<thead>
<tr>
<th>K</th>
<th>DF</th>
<th>L.R. Chisq</th>
<th>Prob</th>
<th>Pearson Chisq</th>
<th>Prob</th>
<th>Iteration</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>8</td>
<td>8.086</td>
<td>.4251</td>
<td>8.186</td>
<td>.4155</td>
<td>4</td>
</tr>
<tr>
<td>3</td>
<td>30</td>
<td>39.493</td>
<td>.1151</td>
<td>36.038</td>
<td>.2069</td>
<td>4</td>
</tr>
<tr>
<td>2</td>
<td>51</td>
<td>234.218</td>
<td>.0000</td>
<td>222.145</td>
<td>.0000</td>
<td>2</td>
</tr>
<tr>
<td>1</td>
<td>59</td>
<td>882.822</td>
<td>.0000</td>
<td>985.052</td>
<td>.0000</td>
<td>0</td>
</tr>
</tbody>
</table>

Tests that K-way effects are zero.

<table>
<thead>
<tr>
<th>K</th>
<th>DF</th>
<th>L.R. Chisq</th>
<th>Prob</th>
<th>Pearson Chisq</th>
<th>Prob</th>
<th>Iteration</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>8</td>
<td>648.604</td>
<td>.0000</td>
<td>762.907</td>
<td>.0000</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>21</td>
<td>194.725</td>
<td>.0000</td>
<td>186.107</td>
<td>.0000</td>
<td>0</td>
</tr>
<tr>
<td>3</td>
<td>22</td>
<td>31.407</td>
<td>.0881</td>
<td>27.852</td>
<td>.1806</td>
<td>0</td>
</tr>
<tr>
<td>4</td>
<td>8</td>
<td>8.086</td>
<td>.4251</td>
<td>8.186</td>
<td>.4155</td>
<td>0</td>
</tr>
</tbody>
</table>

Backward Elimination (p = .050) for DESIGN 1 with generating class

\( \text{CLASS} \times \text{AGE} \times \text{SEX} \times \text{VOTE} \)
Likelihood ratio chi square = 0.0000  DF = 0  P = 1.000

If Deleted Simple Effect is    DF    L.R. Chisq Change  Prob  Iter
CLASS*AGE*SEX*VOTE  8    8.086    .4251    4

Step 1
The best model has generating class

CLASS*AGE*SEX
CLASS*AGE*VOTE
CLASS*SEX*VOTE
AGE*SEX*VOTE

Likelihood ratio chi square = 8.08611  DF = 8  P = .425

If Deleted Simple Effect is    DF    L.R. Chisq Change  Prob  Iter
CLASS*AGE*SEX    8    3.158    .9240    3
CLASS*AGE*VOTE  8    17.195    .0281    4
CLASS*SEX*VOTE  2    2.056    .3577    4
AGE*SEX*VOTE  4    6.153    .1880    3

Step 2
The best model has generating class

CLASS*AGE*VOTE
CLASS*SEX*VOTE
AGE*SEX*VOTE

Likelihood ratio chi square = 11.24431  DF = 16  P = .794

If Deleted Simple Effect is    DF    L.R. Chisq Change  Prob  Iter
CLASS*AGE*VOTE  8    17.958    .0215    3
CLASS*SEX*VOTE  2    1.550    .4608    3
AGE*SEX*VOTE  4    8.004    .0914    3
Step 3
The best model has generating class

\[
\begin{align*}
\text{CLASS*AGE*VOTE} \\
\text{AGE*SEX*VOTE} \\
\text{CLASS*SEX}
\end{align*}
\]

Likelihood ratio chi square = 12.79409  DF = 18  P = .804

.... more steps

Step 6
The best model has generating class

\[
\begin{align*}
\text{CLASS*AGE*VOTE} \\
\text{SEX*VOTE}
\end{align*}
\]

Likelihood ratio chi square = 22.91803  DF = 28  P = .737

---

If Deleted Simple Effect is  DF  L.R. Chisq Change  Prob  Iter
CLASS*AGE*VOTE  8  18.281  .0192  4 
SEX*VOTE  1  10.890  .0010  2 

The final model has generating class

\[
\begin{align*}
\text{CLASS*AGE*VOTE} \\
\text{SEX*VOTE}
\end{align*}
\]

Goodness-of-fit test statistics

\[
\begin{align*}
\text{Likelihood ratio chi square} &= 22.91803  \quad \text{DF} = 28  \quad P = .737 \\
\text{Pearson chi square} &= 22.18494  \quad \text{DF} = 28  \quad P = .773
\end{align*}
\]

Thus non-significant interaction terms are removed one at a time until all those left are significant. For this data the final model is:

\[
\text{VOTE*SEX + VOTE*CLASS*AGE}
\]

Thus the relation of VOTE to CLASS and AGE requires a three-way interaction, indicating that the relation of voting preference to AGE is not the same in each CLASS. However SEX only enters as a two-way interaction with VOTE, indicating that gender differences in voting preference are the same for all AGE groups and CLASS groups.


### Interpretation of Parameters

Having used **Model Selection** to decide on a suitable model we must refit using **General** to obtain details such as parameter estimates.

Here is the edited output from the analysis of the VOTE data.

**GENERAL LOGLINEAR ANALYSIS**

**Design:** Constant + AGE + CLASS + SEX + VOTE + SEX*VOTE + CLASS*AGE*VOTE

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Aliased Term</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Constant</td>
</tr>
<tr>
<td>12</td>
<td>[VOTE = 1]</td>
</tr>
<tr>
<td>13</td>
<td>[VOTE = 2]</td>
</tr>
<tr>
<td>14</td>
<td>[SEX = 1][VOTE = 1]</td>
</tr>
<tr>
<td>15</td>
<td>[SEX = 1][VOTE = 2]</td>
</tr>
<tr>
<td>16</td>
<td>[SEX = 2][VOTE = 1]</td>
</tr>
<tr>
<td>17</td>
<td>[SEX = 2][VOTE = 2]</td>
</tr>
</tbody>
</table>

(+more lines)

<table>
<thead>
<tr>
<th>Chi-Square</th>
<th>DF</th>
<th>Sig.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Likelihood Ratio</td>
<td>22.9198</td>
<td>28</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Estimate</th>
<th>SE</th>
<th>Z-value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>3.4387</td>
<td>.1295</td>
<td>26.56</td>
</tr>
<tr>
<td>12</td>
<td>-.5566</td>
<td>.2220</td>
<td>-2.51</td>
</tr>
<tr>
<td>14</td>
<td>-.3732</td>
<td>.1133</td>
<td>-3.29</td>
</tr>
</tbody>
</table>

(+more parameters)

As this is a **log-linear** model the main effect parameters are differences in **log**-probabilities, which are related to **odds**. Consider AGE group 5 ( <26 ) and CLASS 3 ( Working ). Then for **females** we compute the odds of Conservative versus Labour as:

\[
\text{odds Cons:Lab} = \exp(-0.5566) : 1 = 0.573 : 1
\]

which can be converted to probabilities: (0.573/1.573, 1/1.573) = (0.364,0.636)

For **males** we have:

\[
\text{odds Cons:Lab} = \exp(-0.5566 – 0.3732) : 1 = 0.395 : 1
\]
which are equivalent to probabilities (0.283,0.717)

The ratio of the odds for males to females = 0.395/0.573 = 0.689 = exp(-0.3732)

Thus from the interaction parameter (-0.3732) we can get a direct interpretation in terms of an odds ratio = 0.689. Since SEX only occurs in this model in the interaction VOTE*SEX this odds ratio is constant for all ages and classes. Thus the odds for voting Conservative are about 31% less for males of all ages and class.

The qualitative interpretation is straightforward. The interaction parameter for male and Conservative is negative indicating that the probability of voting Conservative is lower for males. A useful rule-of-thumb is that the maximum change in probability (occurring with probabilities around 0.5) is the interaction parameter divided by 4, i.e. about –0.1 in our example. This approximate result is accurate for values of the parameter between ±1.

Continuous Covariates

Interactions involving continuous covariates can be built and included as terms in a log-linear model. The covariate is specified as a Cell Covariate and can then be used in the Model specification.

The interaction is then modelled as a “trend” with respect to this covariate. Such models are closely related to logistic regression models. In fact, for a binary dependent variable the two ways of specifying the model are exactly equivalent.

General Loglinear

Covariates: XAGE (copy of AGE values)

Model: AGE + CLASS + SEX + VOTE + CLASS*VOTE + SEX*VOTE + VOTE*XAGE

Correspondence Between Parameters and Terms of the Design

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Aliased Term</th>
</tr>
</thead>
<tbody>
<tr>
<td>14</td>
<td>[CLASS = 1]*[VOTE = 1]</td>
</tr>
<tr>
<td>20</td>
<td>[SEX = 1]*[VOTE = 1]</td>
</tr>
<tr>
<td>24</td>
<td>[VOTE = 1]*XAGE</td>
</tr>
</tbody>
</table>

Goodness-of-fit Statistics

<table>
<thead>
<tr>
<th>Chi-Square</th>
<th>DF</th>
<th>Sig.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Likelihood Ratio</td>
<td>51.9665</td>
<td>47</td>
</tr>
</tbody>
</table>
### Logistic Regression (Dependent = VOTE)

#### Parameter Estimates

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Estimate</th>
<th>SE</th>
<th>Z-value</th>
<th>Asymptotic 95% CI Lower</th>
<th>Asymptotic 95% CI Upper</th>
</tr>
</thead>
<tbody>
<tr>
<td>14</td>
<td>1.6497</td>
<td>.1674</td>
<td>9.85</td>
<td>1.32</td>
<td>1.98</td>
</tr>
<tr>
<td>16</td>
<td>1.2893</td>
<td>.1510</td>
<td>8.54</td>
<td>.99</td>
<td>1.59</td>
</tr>
<tr>
<td>20</td>
<td>-.3732</td>
<td>.1133</td>
<td>-3.29</td>
<td>-.60</td>
<td>-.15</td>
</tr>
<tr>
<td>24</td>
<td>-.0156</td>
<td>.0035</td>
<td>-4.42</td>
<td>-.02</td>
<td>-8.69E-03</td>
</tr>
</tbody>
</table>

#### SPSS commands for Log-Linear Models

**Loglinear**

**General**

Fits general loglinear models. Continuous covariates included as Cell Covariates

**Model Selection**

Build model through Model dialog box, specifying interactions in usual way. Parameter estimates requested in Options, store predicted values through Save.

**Loglinear**

**Model Selection**

Allows backward stepwise procedures to select model. Only Factors allowed. Starting model defined in Model dialog box. Can specify model as All n-way interactions.
Parameter estimates are not available.

**Loglinear**

**Logit**

Fits Logistic models via the equivalent log-linear model. Need to take care in specifying the model to get expected results. Continuous covariates specified as **Cell Covariates**. Saved predicted values are expected cell counts not predicted probabilities.

**Regression**

**Multinomial Logistic**

Fits generalised Logistic models for multi-category data. Factors and Covariates specified as in General Linear Models and terms built in the same way through **Model**. Predicted probabilities can be displayed through **Statistics** but cannot be saved.

**Regression**

**Binary Logistic**

If one of the categorical variables is Binary and is taken as the **dependent** variable gives results equivalent to specific log-linear model. **Model** specification more cumbersome, Factors have to be included then declared as **Categorical**. Predicted probabilities can be **Saved**.

**Practical Session 7: Log-Linear Models**

Using the STATLAB data (statlaba.sav)

1. Examine the interactions (associations) between MTE, MTO, FTE and MTO.
   (i) Firstly by specifying models and comparing them.
   (ii) Secondly, using the model selection procedure to find the “best” model.

Using the BSAS data (bsas91.sav)

2. The interaction between PRSOCCL and SRSOCCL is a social mobility effect. Does this effect differ between males and females?

3. There is a strong association between HEDQUAL and PRSOCCL. Does this vary with RSEX?